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Introduction 

This Job Aid is intended for all CONNECTIONS users. It provides a detailed overview of the 
CONNECTIONS system changes being introduced with Build 18.9.6.  

With the implementation of Build 18.9.6, several important changes will improve the 
CONNECTIONS system. It should be noted that many of the enhancements included in this 
Build originated from a collaborative effort on the part of OCFS, local district and voluntary 
agency casework and supervisory staff, who were members of the Functional Improvement 
Team (FIT). Specifically, this Job Aid contains information about enhancements in the following 
functional areas: 

• Foster and Adoptive Home Development (FAD) 

• Out of State SCR Check Window 

• Family Assessment and Service Plans (FASPs), including the Service Plan Review 

• Life Skills Assessment Comments Window 

• Health Services 

• Permanency 

• Progress Notes 

• Security 

 

 

Any visible identifying data 
in this Job Aid is simulated. 

 

 

This Job Aid assumes familiarity with the 
CONNECTIONS System. 

 
This Job Aid is available online on the CONNECTIONS intranet site: 

OCFS.state.nyenet/connect/jobaides.asp 

The CONNECTIONS intranet site also contains information about CONNECTIONS training. 
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 Foster and Adoptive Home Development (FAD) 

Fingerprint Letters 
On January 11, 2007, foster boarding home and adoption regulations were amended on an 
emergency basis to require FBI fingerprint checks for prospective foster and adoptive parents 
and those persons age 18 and over residing in a FAD home prior to the home’s initial 
certification/approval or if an individual 18 years of age or older is added to an existing home, 
prior to reauthorization. The regulations became effective as final regulations on October 10, 
2007. With the implementation of Build 18.9.6, a revised notice letter (English and Spanish) and 
a revised denial/revocation letter (English and Spanish) are supported in CONNECTIONS. The 
foster or adoptive caseworker is responsible for providing applicants with the notice that they 
and all people age 18 or older residing in the home must be fingerprinted and sending the 
denial/revocation letter, as appropriate. In addition, the Acknowledgement and Consent Form 
for Fingerprinting and Disclosure of Criminal History Record Information form is available in 
CONNECTIONS for use only by voluntary authorized agencies. This consent form only pertains 
to the FBI criminal history record check and is required for New York State to comply with 
current FBI limitations on the dissemination of criminal history record information to non-public 
agencies. The signed consent form is to be submitted with the fingerprint cards.   

CONNECTIONS provides the ability for caseworkers to 
generate, print and store these letters in the database. An 
event is also created when a letter is generated for the stage.  
Stage and person specific information is system filled, as 
appropriate, in these letters. 

Menu commands are enabled for FAD cases with a setting 
type of Adoptive or Foster Home. Any worker with a role in the 
stage or access to the workload may generate the letters from the Person List window. 

 
There is space at the top of the 

letters for your agency’s 
letterhead. Be sure to print the 

letter on agency letterhead. 

 

Step by Step: 
Generating and Printing the FAD Fingerprints Notice, Denial/Revocation and 
Consent Letters 

1 On the Assigned Workload, select the home for which you need to send 
a letter. 
The Tasks… button enables. 

2 Click on the Tasks… button. 
The Task List displays. 

3 On the Task List, select the Maintain Person task. 
4 Click on the List… button.  

The Person List displays. 
5 Click on the Reports menu and the appropriate letter. 
6 Click on the OK button in response to the following message: 

“The report has been launched. Check Report List Window.” 
Letters remain unopened on the Report List for seven days before being purged. 

7 Click on the RPRTS (Reports) button on the far right side of the CONNECTIONS 
Toolbar. 
The Report List displays. 
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8 Confirm that the Status column reads “Done” for the letter you want to view. If it 
does not read “Done,” click on the Refresh button at the bottom of the window. 

9 Click on the letter to select it. 
The Open button enables. 

10 Click on the Open button. 
The FAD Fingerprint Letter displays as a Microsoft Word document. 

11 To print the letter, click on the File menu and select Print. 
The Microsoft Word Print dialog box displays. 

12 Click on the OK button to print. 
13 To close the letter, click on the File menu and select Close. 

The Report List displays. 
14 To close the Report List, click on the Close button. 

The Person List displays. 

Out of State FBI Background Checks 
The Out of State SCR Check Window 
With the implementation of Build 18.9.6, the Out of State SCR Check window provides workers 
with a location for recording information pertaining to out-of-state child abuse and neglect 
background checks performed on prospective foster or adoptive parents (or other persons in the 
home 18 years of age). Such a background check is required for all prospective foster or 
adoptive parents (or any other persons 18 years or older in the home) via the child abuse and 
neglect registry in each state they have resided in the five years prior to application.  The 
definition of “state” includes: the District of Columbia, Commonwealth of Puerto Rico, the U.S. 
Virgin Islands, Guam and American Samoa. 

To display the Out of State SCR Check window, select a person by clicking his or her name in 
the upper grid of the Household Member Detail tab located on the Foster and Adoptive Home 
Record Summary window and click the O/O/S SCR Check button. 
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Step-by-Step: 
Accessing the Out of State SCR Check Window 

1 Click on the WORK button on the CONNECTIONS 
Toolbar. 
The Assigned Workload displays. 

2 Select a FAD home and click on the Tasks… button. 
The Task List displays three tasks that can open the 
FRS window. 

3 Select the Home Study task to open the FRS. 
4 Click on the corresponding button. 

For example, if you select the Home Study task you would click on the New or Use 
Prior button.  

5 Click on the New, Detail or Use Prior button (Detail is enabled when there is an  
in-process FRS). 
The FRS displays. 

6 Click on the Household Member Detail tab. 

7 Click on the O/O/S SCR Check button. 
The Out of State SCR Check window displays. 

In the Out of State SCR Check window, workers must record the state to which the request was 
sent and the date it was sent for the person listed at the top of the window. Once a response is 
received, the results and the date the results were received must be entered. 

Once information has been saved in the Out of State SCR Check window, a system-generated 
check mark displays in O/O/S SCR Check check box in the Household Member Detail tab. 

The grid consists of the following columns: 

State The State drop-down contains a list of the state 
or location to which the request will be sent. 
This drop-down field will include the following 
states in addition to all states: 

• District of Columbia 
• Puerto Rico 
• United States Virgin Islands 
• Guam 
• American Samoa 

Requests to multiple states may be sent and 
are listed separately. 

Date Sent The date on which the request for the SCR background check was 
sent to another state. This field is required and displays in the 
following format mm/dd/yyyy. 

Date The date on which the response to the request was received. The 
date recorded cannot precede the Date Sent entry and cannot be 

 
Multiple records may be added 

prior to saving.  

 
The State of New York will not 

be listed since a New York State 
(In-state) SCR background 
check is performed on the 

Household Member Detail tab of 
the FRS. 

Page 4 
CONNECTIONS –System Build 18.9.6 Job Aid Revised(4/7/2008) 



Received a future date. The following message displays if the Date received 
precedes the Date Sent: 

“Date Received cannot precede the Date Sent.” 

This field is required and displays in the following format 
mm/dd/yyyy. 

Results This column contains the following options: 

• No Record Found 

• Record Received 

• Unable to Release 

The window contains the following buttons: 

Delete This button deletes the selected row on the grid after saving the 
record to the window. 

Save  Clicking on the Save button saves any modifications made in the 
Out of State SCR Check window and closes the window. This 
button is enabled once a modification is made in the window. The 
following message displays when saving a row with an incomplete 
State or Date Sent field: 

“State and Date sent are required” 

When you record the Date Received you must also record the 
Results or the following message displays: 

“Date Received and Results are required” 

Cancel Clicking on the Cancel button displays the following message:  

“Do you want to cancel? Unsaved data and/or narrative(s) will be 
lost.” 

• Click on the Yes button to discard all changes made since 
the last save.  

• Click on the No button to remain on the window without 
discarding the changes.  

This button is always enabled upon entering the window. 
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Step-by-Step: 
Recording Out of State SCR Check 

1 Click on the State drop-down to the desired state. 
The Save button enables. 

 
Where am I? 

Assigned Workload > Tasks > 
FAD stage > Home Study task > 
Household Member tab > O/O/S 

Check button 

2 Click in the Date Sent field and record the date the 
request was sent. 

3 Click in the Date Received field and record the date 
the result was received. 

4 Click in the Results field and record the appropriate 
result. 

5 Click on the Save button to store your comments. 
The following message displays: “Changes have been saved.” The Household 
Member Detail window displays.  

 

FA License Window  
Certification or approval of a foster home includes recording all required licensing information on 
the F/A Home License window. With the implementation of Build 18.9.6, an Out of State SCR 
Check check box displays on the Home License window. The checkbox initially defaults to being 
checked to indicate that the home is not currently awaiting results. The check box will only 
appear unchecked if an Out of State SCR Check date sent is recorded and there is no 
corresponding date received.  When the check box is unchecked, CONNECTIONS prevents 
initial certification or reauthorization of a home until date received/results are recorded. The 
home may be opened in “Emergency” status pending receipt of the results.  

FAD Events and Alerts 
With the implementation of Build 18.9.6, FAD workers and their supervisors will be notified when 
a CPS Investigation involving a person listed in an assigned FAD stage has been completed. 
The worker will not receive information regarding the outcome of the investigation, but may 
contact the CPS worker for more information.   

The following alert is sent to the Foster Home licensor and his or her supervisor in FAD:  

“CPS Investigation Complete for stage id <stage id>.” 

Additionally, upon approval of the determination, an Event will be created on the Foster Home 
FAD stage: “CPS Investigation Complete for stage id <stage id>.” 

 

Family Service Stage 

Prior to Build 18.9.6, when two Family Services Stages are merged workers were not able to 
print Progress Notes for the closed stage. With the implementation of Build 18.9.6, the Merge 
Case Batch will be updated to assign a new case number to the closed case.  This change will 
provide workers the ability to print Progress notes. 
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Prior to the implementation of Build 18.9.6, a supervisor received an error message when 
navigating from an Approval To-Do to the FSS Closure window if the worker who submitted the 
closure for approval is end-dated. The approver no longer receives an error message when 
navigating to the FSS Closure window when the worker who submitted the FSS closure for 
approval is end-dated before the approval is completed. 

Family Assessment and Service Plans (FASPs) 

Historical Access 
With the implementation of Build 18.9.6, a worker with an historical role in an FSS can view all 
of the FASPs associated with the case that existed before the worker’s assignment ended via 
the Event List.  

Life Skills Assessment  
The Life Skills Assessment is a checklist which should be completed after the worker has 
completed/reviewed a recent separate comprehensive life skills assessment of the youth. Based 
on this comprehensive assessment and the worker’s knowledge of the youth’s abilities and 
needs, the Life Skills Assessment sub-node will support the worker’s assessment of the 
knowledge and capability a child has regarding specific life skills and enable them to determine 
whether further instruction in individual areas is necessary for the youth to acquire, enhance or 
maintain those skills. The Life Skills Assessment aids workers in developing the appropriate 
service plan for the child.  

With the implementation of Build 18.9.6, the Life Assessment Skills information will not display 
in the Foster Care Issues (FCI) and Non-LDSS Custody sections for children with end-dated 
program choices of Placement or Non-LDSS Custody. 

The Life Skills Assessment Comments Window 
The Life Skills Assessment Comments window has been added with the implementation of Build 
18.9.6. This window provides the worker who is associated with a child, and the case planner, a 
place to record narratives supporting the decisions made in each section of the Life Skills 
Assessment. The comments are to contain specific examples of individual behavior or 
functioning that supports the selected response for a specific scale. Additionally, the worker can 
record comments for one or all children on the Life Skills Assessment Comments window. 

The Life Skills Assessment Comments window is comprised of a header, footer and multiple 
fields. The header contains the File, Options and Help menus. The footer contains various 
buttons. This window is accessible from the Life Skills Assessment window via the Comments 
button. All workers with a role in the stage can view the Life Skills Assessment and any related 
comments. 

 

Step-by-Step: 
Accessing the Life Skills Assessment Comments Window 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Select the FSS stage and click on the Tasks… button. 
The FSS displays. 
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3 Click on the Family Assessment and Service Plan tab. 
The Family Assessment and Service Plan window displays, with the FASP Tree 
(containing FASP types and corresponding nodes) on the left side of the window. 

4 Click on the ‘+’ next to the in process FASP. 
The corresponding nodes and sub-nodes display. 

5 Click on the ‘+’ next to the Foster Care Issues node. 
The Foster Care Issues node expands. 

6 Click on the Life Skills Assessment sub-node. 
The Life Skills Assessment window displays. 

7 Click on the Comments buttons. 
The Life Skills Assessment Comments window displays. 

 

The Life Skills Assessment Comments window contains the following fields: 

Please Select 
the Child 
These 
Comments 
Apply To 

The Select Child drop-down field allows the worker to select the 
child for whom comments are being recorded.  

The Comments field is disabled until the worker selects a child 
from the list (or until the worker selects the Apply to all in list 
checkbox).  

Apply To All 
In List 

The Life Skills Assessment Comments window contains the Apply 
to all in list checkbox, which enables the worker to record one 
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checkbox comment and apply it to all children in the Life Skills Assessment 
window.  

The checkbox enables only when: 

• the worker is the case planner or has been associated 
to all tracked children in the list 

• all existing comments apply to all children in the list, or 
no comments exist for any of the children in the list 

Modified By The Modified By field displays the name of the worker who last 
modified a comment on the window. 

Date The Date field displays the date the worker last saved information 
on the window. 

Comments The Comments field enables when a child has been selected in 
the Select Child drop-down, or when the Apply to all in list 
checkbox has been selected. This field is modifiable if the worker 
is the case planner or has been associated to all tracked children 
in the list. 
Comments are to contain specific examples of individual behavior 
or functioning that supports the selected response. 

The window contains the following buttons: 

Spell Check Click on the Spell Check button to spell check the text entered in 
the comments field. This button is enabled once a modification is 
made to the window. 

Save  Clicking on the Save button saves any modifications made in the 
Life Skills Assessment Comments window. This button is enabled 
once a modification is made in the window. 

Cancel Clicking on the Cancel button displays the following message:  

“Do you want to cancel? Unsaved data and/or narrative(s) will be 
lost.” 

• Click on the Yes button to discard all changes made since 
the last save.  

• Click on the No button to remain on the window without 
discarding the changes.  

This button is enabled once a modification is made in the Life 
Skills Assessment Comments window. 

Close The Close button closes the Life Skills Assessment Comments 
window. If you have not already saved, the following message 
displays: 

“Do you want to exit? Unsaved data and/or 
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narratives will be lost.” 

• If you click the Yes button, the window closes without 
saving any changes.  

• If you click the No button, the message box closes and 
all changes remain pending. 

 

Step-by-Step: 
Recording Life Skills Assessment Comments 

 
Where am I? 

Assigned Workload > Tasks > 
Family Assessment and Service 
Plan tab > Foster Care Issues 

sub-node > Life Skills 
Assessment sub-node 

>Comments button 

1 Select a child from the Select Child drop-down field. 
If only one child exists, only that child displays and 
the Select Child field is disabled. If multiple children 
exist, the Apply to All in list checkbox displays and 
you can select it to apply the comments to all of the 
children. You may only select Apply to All in list if 
you are the Case Planner or have been associated to 
all of the tracked children. 

2 Record your comments for the child(ren) in the 
Comments field.  
The Spell Check and Save buttons enable. 

3 Click on the Spell Check button to check your text.  

4 Click on the Save button to store your comments. 

5 Click on the Close button to return to the Life Skills Assessment window.  

Changes to the Outcome and Activity (O&A) Block  
The Service Plan window contains the Outcome and Activity (O&A) Index. This term is used to 
describe a cluster of problem/concern statements that specify the behavior, the underlying 
condition or circumstance that needs to change, the services that will support that change, and 
statements of the desired result/outcome of that change. Outcome and Activity Blocks are 
carried forward from previous FASPs.  

Prior to the implementation of Build 18.9.6, O & A blocks with a status of Discontinued or End-
Closing Stage did not print in the current FASP. With the implementation of Build 18.9.6, the O& 
A Blocks that were updated to a status of Discontinued or End-Closing Stage in the current 
FASP will print when the FASP is printed. 
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The following additional changes were made to the FASP with the implementation of Build 
18.9.6: 

• The effective date for a selected program choice can be back dated to the last 
approved FASP. 

• When a Program Choice of Placement has been end dated, the Placement 
Information section in the Stage Composition of the FASP report no longer 
populates.  

• When a child has a Program Choice of Non-LDSS Custody, completion of Placement 
and Planning Issues “Record Return Home” tab is not required and will not appear 
on the Check FASP Detail window. If a worker saves information on the tab, then the 
“Record Return Home” tab will appear in the Check FASP Detail list to determine 
completeness.  

• Prior to the implementation of Build 18.9.6, the status review column in the Visitation 
Plan Sub-Node for Non-LDSS custody cases did not reflect updates being completed 
upon saving. Now, when information is recorded on the Visiting Plan Review tab a 
status of “Complete”, displays regardless of the type of custody. 

• Information recorded and saved for the sub-categories on the Programmatic 
Eligibility window will now display when a worker re-enters the window. 
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Health Services 

Biological Family Health Information window 
This Biological Family Health Information window provides for recording additional health 
information about the family that is pertinent to the child. No information concerning HIV/AIDS 
on family members is to be recorded here. With the implementation of Build 18.9.6, the following 
message displays when no parents are recorded on the Family Relationship Matrix or multiple 
mothers or fathers are found and the “no primary caretaker exists” checkbox has not been 
checked: 

“No active mother or father exists. Mother/Father column cannot be generated.” 
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Permanency 

Court Information Window 
The Court Information window is the location in CONNECTIONS for recording the court 
information that populates the Notices and Statement. All fields (with the exception of the Court 
Part or Room field and the Petitioner Information section) must be completed in order to 
generate a Permanency Hearing Notice and Statement. Once all required fields are complete 
and saved, the Complete checkbox on the Permanency Hearing Notices and Statements 
window is automatically populated. 

With the implementation of Build 18.9.6, the Petitioner Information section was added to the 
Court Information window. The Petitioner Information section is used to record information about 
the Petitioner and the Petitioner's attorney. 

 

The Petitioner Information section contains the following recordable fields: 

Petitioner 
Name 

The name of the petitioner. 

Page 13 
CONNECTIONS –System Build 18.9.6 Job Aid Revised(4/7/2008) 



Attorney(s) 
for 
Petitioner(s) 

The name of the petitioner’s attorney. 

Title The Title of the petitioner. 

Address Info The street address of the petitioner. 

Address Info The street address of the petitioner’s attorney. 

Address Info The City, State and ZIP Code associated with the address of the 
petitioner. 

Address Info  The City, State and ZIP Code associated with the address of the 
petitioner’s attorney. 

Phone The telephone number of the petitioner. 

Ext The extension associated to the petitioner’s telephone number. 

Phone The telephone number of the petitioner’s attorney. 

Ext The extension associated to the attorney’s telephone number. 

 

Step-by-Step: 
Recording Petitioner Information 

 
Where am I? 

Assigned Workload > Tasks > 
Permanency tab > Notices & 

Statement Button > Court 
Information button 

1 Record the Petitioner's name and title in the 
Petitioner Name and Title fields, respectively. 

2 Record the primary, and if applicable, secondary 
street addresses of the Petitioner in the Address Info 
fields. 

3 Record the Petitioner's phone number and extension 
in the Phone and Ext fields, respectively. 

4 Record the name of the Petitioner's attorney in the 
Attorney(s) for Petitioner(s) field. 

5 Record the primary, and if applicable, secondary street addresses of the Petitioner's 
attorney in the Address Info fields. 

6 Record the Petitioner's attorney's phone number and extension in the Phone and Ext 
fields, respectively. 

7 Click on the Save button. 
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Child Protective Case Summary 

Investigation Conclusion 
With the implementation of Build 18.9.6, the following additional changes were made to the 
Investigation Conclusion: New closure reasons have been added to Day Care/ Foster Care 
Child Protective investigations to correct FSIs being created in error for these investigations. 
When concluding a Day Care/ Foster Care Child Protective investigation the Indicated and 
Unfounded Open Closure reasons disable and the following closure reasons display: 

• Corrective Action Required 

• No Corrective Action Required 

• Unable to Contact/Moved Out of Jurisdiction 

Prior to the implementation of Build 18.9.6, information recorded in all sections of the 
Investigation Conclusion Narrative template were unprotected and modifiable. With the 
implementation of Build 18.9.6, the Investigation Conclusion Narrative is a protected document; 
caseworkers are to record conclusion information in selected unprotected sections.  
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Progress Notes 

Searching for a Progress Note 
Progress notes are recorded and maintained for all child protective services investigations and 
all child welfare services cases, providing documentation of all worker activities in an objective 
and behaviorally specific way. Progress notes document the timely activities of casework staff 
and the information acquired during these activities.  

The Type, Method of Contact, Author and Narrative fields are required for any note. Depending 
on the criteria selected for Type and Method of Contact, other fields (i.e. Purpose) may also be 
required.  

With the Implementation of Build 18.9.6 the following new Type values have been added to 
progress notes: 

• Notice 

• Approval 

(Notice/Approval remains available as a single value) 

• Other Casework Activity 

The following new Purpose values have been added to progress notes: 

Under the Progress Note Type of Approval, the purposes are:  

• LDSS Exec Level Approval  

• VA Exec Level Approval 

Under the Progress Note Type of Other Casework Activity the purposes are: 

• Cross Reference  

• Case Closing  

• Transfer  

Voluntary agency workers will not be able to view Child Protective Record Summary Progress 
Notes with the Type of “Other Casework Activity” and Purpose of “Cross Reference.”  
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Additional Updates 

In addition to including “American Samoa” in the drop down of states for Out of State SCR 
Checks, the data value has been added to the Person Detail drop-down list to be used when 
recording addresses.  

Spell and Grammar Checker 
With the implementation of Build 18.9.6, the Spell Checker has been improved and new text 
features Grammar Checker and Thesaurus has been added to the text tool bar. Spell check will 
verify the spelling of words and underline misspelled words. The worker selects the correctly 
spelled word from the list of spellings for the word.  

Clicking on the Grammar Check button provides for checking the grammatical wording of the 
text. Clicking on the Thesaurus buttons provide workers with a listing of synonyms for the word 
that the cursor is currently on. These buttons display on all narrative windows and tabs with the 
text tool feature. This update also adds commonly used words to the custom dictionary. 
Misspelled words will remain underlined until corrected. Plurals will no longer display as 
misspelled.  

When workers access a window or tab containing the Text Control tool, they can use 
formatting functions (similar to those available in Microsoft Word) for the text recorded in the 
narrative field.  

The Spell and Grammar Check has also been added to the Permanency Hearing Report. 
However, because the permanency hearing report is a template, the text tool works somewhat 
differently. A Caseworker must highlight the text in the enterable field and activate the 
spell/grammar check. Spell/Grammar check will not work if areas other than enterable fields 
have been highlighted. In the Permanency Hearing Report you can only spell/grammar check 
one section at time. 

Two separate toolbars display at the top of the narrative field. The first toolbar contains buttons 
for performing the following functions: 

Print This option allows workers to print the narrative. 
Print Preview This allows the text to be viewed on screen, as it will appear when 

printed. 
Spell Check Workers can conduct a Spell Check of the text recorded. Workers 

cannot add items to the dictionary. Spell check is available for the 
entire document or for a highlighted section within the document. 

Copy Select text to be copied to a clipboard; the clipboard clears when 
tab/window closes. 

Cut This option allows selected text to be removed and placed on the 
clipboard. 

Paste Text that was saved to the clipboard (via copy or cut) can be pasted 
within the text area. 

Find This option enables workers to search the narrative for specific words 
or phrases. 

Find and 
Replace 

This option enables workers to search the narrative for a specific 
word or phrase and replace it with another word or phrase. 
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Grammar Check  Workers can conduct a Grammar Check of the text recorded. 

The second toolbar contains standard text formatting buttons: 
Bold  Selected text is bolded. 

Italics  Selected text is italicized. 

Underline  Selected text is underlined. 

Align Left This allows left alignment of text. 

Align Right This allows right alignment of text. 

Center  This allows center alignment of text. 

Justify  This allows full justification of text. 

Numbering  This function formats selected text as a numbered list. 

Bullets  This function formats selected text as a bulleted list. 

Zoom  The view of the text size can be changed from 10% to 400% as it is 
being typed into the text section. The text will return to the standard 
Times Roman 12pt once the window or tab has been saved. 
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Security 

The Unit Specializations displays the primary function of a unit (e.g. Intake or Adoption). With 
the implementation of Build 18.9.6, this field will be updated. The following table contains 
updated Unit Specializations: 

 
The following additional changes were made to Security with the implementation of Build 18.9.6: 

• For the Health Module, for closed stages, workers in districts other than that of the 
Case Manager or Case Planner (Case Workers or CPS Worker / Monitor) assigned 
at the time of stage closure with the VIEW HEALTH Business Function may view 
health for the children for whom their agency was designated. The data will be 
filtered to return only those records entered prior to the end of responsibility of the 
agency.  This also applies to workers that were end dated prior to the closing of the 
stage.  

• The Education module will contain a new Business Function called ENTER 
EDUCATION. The Security Attribute for this Business Function will be listed as an 
option on the Security Profile Maintenance window but will not be available to use 
until the Business Function is added in a future build. 

• CPS stages not classified as Indicated, Unfounded, Under Investigation, or 
Administrative Review (ARI) can be accessed by workers with the Access All Cases 
Business Function. This now includes stages classified as Additional Information. 

• A voluntary agency worker who is able to maintain FAD and has a role in the Family 
Services Stage can not access FAD homes via their implied role. 

Code Decode
ADL Adolescent
AOB Agency Operated Boarding Home
AST Initial Assessment 
CRI Crisis Residence
DAS PINS-Diagnostic Program
DRC Diagnostic Reception
EDN Educational Neglect
FCM FosterCareMixedUnit
GHO Group Home
GPR Group Residence
INP Intensive Preventive
JJI JuvenileJusticeInitiative
MAT Maternity Residence
MCH Mother Child
PNS PINS-Long Term Program
RTC Residential Treatment Center
SLP Supervised Independent Living Program

Build 18.9.6 - Unit Specialization Codes



Service Plan Reviews 

With the implementation of Build 18.9.6, the Service Plan Review Notification Letter has been 
updated to include valid phone numbers for Case Managers. 
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Support Tools 

Online Help 
CONNECTIONS Online Help provides descriptions for various windows, as well as step-by-step 
instructions for common tasks. You can access Online Help at any time, from any window in 
CONNECTIONS by clicking on the Help menu or pressing the F1 key on your keyboard. 

The Contents, Index and Search tabs in Online Help allow you to search for and navigate to 
the topic(s) you need help on. 

 

Step-by-Step: 
Accessing Online Help 

1 Click on the Help menu on the CONNECTIONS Toolbar. 
The following list of commands displays: 

Contents A table of contents for the help facility with links to major sections. 
How Do I? Step-by-instructions to help you complete tasks using 

CONNECTIONS.  
Window 
Descriptions 

Descriptions of windows in CONNECTIONS, along with information on 
various fields. 

DSS Policy Online OCFS policy handbooks (under revision). 
Help On This 
Window 

Window description help for the window you are on. 

Help for Help Instructions on how to use the help functionality.  
About 
CONNECTIONS 

Information about the current CONNECTIONS version and build. 

2 Click on a command from the Help menu. 
The window related to your selection displays. In some cases, you will need to make 
another selection in that window to obtain instructions. At the top of each window you 
will see additional buttons and menus. Use the Search button to search for specific 
information in the Help function and use the Back button to return to windows you 
have just visited in Help. The Glossary button opens a list of important 
CONNECTIONS terms and the Print button allows you to print Help information. 

3 When you are done reviewing information in Help, close each Help window by 
clicking on the Close button ( ) in the top right corner of the window. 
The system returns to the window you were using when you accessed Help. 
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Enterprise Help Desk 
The New York State Office for Technology (NYS OFT) Enterprise Help Desk staff is available to 
answer basic questions related to your equipment or to solve problems you are having with the 
CONNECTIONS application. If they cannot solve your problem, they will record your information 
and forward it to others who can. 

Your agency may have procedures in place for contacting the Enterprise Help Desk. Check with 
your supervisor before you call. 

The Enterprise Help Desk is staffed 24 hours a day, seven days a week. The telephone number 
is: 

1-800-NYS-1323 
(1-800-697-1323) 

When you call the Enterprise Help Desk with a problem, you will be given a ticket number to use 
for tracking your issue and its resolution. Keep a record of this number; you will need it for any 
follow-up conversations with the Enterprise Help Desk. 

OCFS CONNECTIONS Intranet Site 
A variety of training-related materials are available from the OCFS CONNECTIONS intranet site 
(http://ocfs.state.nyenet/connect/). The intranet site contains a wealth of information related to 
various aspects of CONNECTIONS, including training schedules, Alerts and Notices, Step-by-
Step Guides (including the CONNECTIONS Case Management Step-By-Step Guide), Job Aids 
and Frequently Asked Questions (FAQs). Release Notes – a complete list of the modifications, 
enhancements, fixes and impacts in the Build – is also available from the CONNECTIONS 
intranet site. 

 

Step-by-Step: 
Accessing the OCFS CONNECTIONS Intranet Site 

1 From your local desktop, double-click on the Internet Explorer icon. 

2 If the browser does not display the OCFS intranet site automatically, enter 
http://ocfs.state.nyenet into the browser’s address line and press the Enter key on 
your keyboard. 
The OCFS intranet home page displays. 

3 Click on the CONNECTIONS link. 
The CONNECTIONS home page displays. 

4 Click on a topic to access information. For access to various Step-by-Step Guides 
and Job Aids, click on the Step-by-Step/Job Aids/Tips link. For access to Release 
Notes for a Build, click on the Implementation link. 

5 To close Internet Explorer, click on the File menu and select Close. 
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